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Abstrak — Kecemasan merupakan gangguan mental yang
sering dialami mahasiswa dan dapat mengganggu
keseimbangan psikologis, akademik, serta sosial. Penelitian ini
mengembangkan aplikasi Neurobliss, perangkat lunak desktop
yang memfasilitasi stimulasi gelombang otak alfa melalui musik
relaksasi dan binaural beats. Stimulasi audio ini bertujuan
meningkatkan aktivitas gelombang alfa (8-13 Hz) yang
berkaitan dengan relaksasi sekaligus menurunkan gelombang
beta yang terkait stres dan kecemasan. Proses stimulasi dan
monitoring menggunakan perangkat Muse EEG (Muse 2 dan
Muse S) yang merekam sinyal listrik otak secara non-invasif.
Data EEG diekspor dalam format CSV dan diproses dengan
MATLAB, meliputi filtering dengan Band Pass Filter (0,5-60
Hz), konversi ke European Data Format, dekomposisi sinyal
dengan Independent Component Analysis untuk
menghilangkan artefak, serta analisis spektral menggunakan
Fast Fourier Transform untuk memetakan distribusi daya pada
pita frekuensi otak. Diharapkan stimulasi audio ini dapat
meningkatkan daya gelombang alfa secara signifikan dan
menurunkan Kkecemasan. Dengan demikian, Neurobliss
menawarkan solusi teknologi untuk monitoring dan analisis
EEG sekaligus menjadi alternatif intervensi dalam pengelolaan
kesehatan mental mahasiswa.

Kata kunci— Binarual Beats, EEG, enchaned alpha,
kecemasan, Neurobliss

L. PENDAHULUAN

A. Latar Belakang

Kecemasan adalah respons terhadap ancaman yang tidak
pasti dan dapat memengaruhi kondisi subjektif, perilaku,
serta fisiologi seseorang. Gangguan kecemasan ditandai
dengan ketakutan berlebihan tanpa alasan jelas dan berbeda
dari kecemasan biasa. Gejalanya meliputi kegelisahan,
kelelahan, kesulitan konsentrasi, mudah tersinggung, dan
gangguan tidur.

Gangguan kecemasan umum terjadi pada remaja dan
mahasiswa. WHO mencatat 11,7-14,7% mahasiswa
mengalaminya, dan di Telkom University sekitar 9—11%.
EEG dapat memantau emosi, dengan gelombang beta terkait

kecemasan dan alfa untuk relaksasi. Binaural beats pada
frekuensi alfa terbukti efektif, namun tetap perlu validasi
profesional.
B.  Analisis Masalah
Analisis masalah dibagi menjadi beberapa aspek, yaitu
aspek psikologi, aspek sosial, aspek budaya dan askpek
teknis.
a. Aspek Psikologi
Anxiety dapat mengganggu emosi seperti gelisah,
sulit tidur, dan hilang nafsu makan. Trauma masa kecil
dapat memicu gangguan emosi (Nicoara N), dan kondisi
mental buruk memengaruhi sistem saraf otonom (Lee J
dkk). Pada penderita kecemasan, amigdala menjadi

overaktif dan medial prefrontal cortex gagal
mengontrolnya, menyebabkan respon emosional
berlebihan.

b. Aspek Sosial

Remaja usia 10-24 tahun rentan terhadap gangguan
mental, terutama di negara berpenghasilan rendah karena
akses layanan kesehatan terbatas. Status ekonomi
rendah, tekanan akademik, dan media sosial negatif
memperburuk kondisi psikologis. Penelitian
menunjukkan bahwa kecemasan berdampak pada
prestasi, hubungan sosial, dan bisa memicu keinginan
bunuh diri.

c. Aspek Budaya

Budaya memengaruhi gangguan kecemasan secara
tidak langsung melalui pandangan diri dan peran sosial.
Contohnya, individu Asia-Kanada yang interdependen
lebih rentan terhadap kecemasan sosial. Di Indonesia,
rendahnya kesadaran mental membuat penderita sering
distigmatisasi.

d. Aspek Teknis

Diagnosis gangguan kesehatan mental hanya dapat
dilakukan oleh psikolog, psikiater, atau ahli terkait,
dengan acuan dari buku DSM-5 yang diterbitkan oleh
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American Psychiatric Association pada tahun 2013.
Namun, teknologi seperti MATLAB dapat digunakan
untuk membantu analisis sinyal, dan machine learning
juga mulai dikembangkan untuk mengenali kecemasan
melalui data EEG atau biomarker lainnya. Inovasi ini
membuka peluang untuk menciptakan perangkat bantu
diagnostik guna mendukung kerja para profesional
kesehatan mental.

C. Twuan

Berdasarkan analisis masalah diatas, tujuan dari tugas
akhir ini adalah melakukan observasi mengenai pengaruh
stimulasi sinyal alfa untuk menurunkan tingkat kecemasan
dari perubahan frekuensi sinyal otak alfa dan beta melalui
analisis sinyal EEG dan memanfaatkan teknologi untuk
memberikan  pendekatan ilmiah dalam pengelolaan
kecemasan melalui suatu aplikasi praktis dengan stimulasi.

IL. KAJIAN TEORI

a. Anxiety Disorder

Gangguan kecemasan merupakan salah satu bentuk
masalah kesehatan mental yang cukup sering dialami oleh
mahasiswa. Kondisi kecemasan yang berlebihan dapat
mengganggu keseimbangan dalam menjalani aktivitas
harian. Mahasiswa dan remaja termasuk kelompok yang
sangat rentan terhadap gangguan ini, karena tuntutan situasi
yang mengharuskan mereka lebih mandiri dalam menghadapi
berbagai persoalan [13].

b. Elektroensefalogram (EEG)

Elektroensefalogram (EEG) pada dasarnya digunakan
untuk merekam aktivitas osilasi listrik dari neuron yang
berada di korteks serebral. Sinyal EEG memuat gelombang
dengan berbagai rentang frekuensi [13]. Aktivitas tersebut
biasanya dikelompokkan menjadi beberapa pita, yaitu delta
(kurang dari 4 Hertz), teta (antara 4 hingga 8 Hertz), alfa (8
sampai 13 Hertz), beta (13 sampai 30 Hertz), dan gamma (30
hingga 100 Hertz) [4].

c¢. Stimulus Enhanced Alpha

Stimulasi enhanced alfa adalah metode untuk
meningkatkan aktivitas gelombang otak alfa (8-13 Hz),
biasanya melalui audio, visual, atau arus listrik rendah [21],
[22]. Otak merespons osilasi dari stimulasi yang diterima.
Teknik ini digunakan dalam terapi nyeri (9 Hz), pengurangan
stres dan kecemasan (10-30 Hz), serta peningkatan memori,
kognisi, dan pemulihan cedera otak (10,2 Hz) [23].

d. Independent Component Analysis (ICA)

Pada dasarnya ICA adalah sebuah teknik untuk
memisahkan sekumpulan sinyal tercampur menjadi sinyal-
sinyal yang independen pada sumber aslinya. Berikut adalah
rumus dasar model ICA:

x =As

Dimana x adalah vektor dari sinyal yang diamati (observed
mixtures), A adalah matriks pencampur yang elemen-
elemennya tidak diketahui (mixing matrix), dan s adalah
vektor dari komponen-komponen independen (source

signals).

e. Band Pass Filter (BPF)
Band Pass Filter (BPF) merupakan alat atau rangkaian
yang memungkinkan sinyal dalam rentang frekuensi tertentu
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(passband) untuk lewat, sambil menekan frekuensi di luar
rentang tersebut [25]. BPF banyak digunakan dalam sistem
komunikasi, radar, dan perangkat elektronik lain untuk
menyaring sinyal yang diinginkan dan mengurangi gangguan
dari frekuensi lain. Band Pass Filter (BPF) dalam pengolahan
sinyal EEG berfungsi untuk menyaring dan membatasi
rentang frekuensi sinyal yang dianalisis, sehingga hanya
frekuensi yang relevan dengan aktivitas otak yang diambil
[26].

f- Fast Fourier Transform (FFT)

Fast Fourier Transform (FFT) adalah algoritma efisien
hasil pengembangan dari Discrete Fourier Transform (DFT),
yang digunakan untuk mengonversi sinyal dari domain waktu
ke domain frekuensi dengan presisi tinggi [28]. Algoritma
FFT dapat memproses transformasi lebih cepat daripada DFT
karena ada pengurangan di proses looping [28]. Transformasi
fourier secara matematis dinyatakan dalam persamaan.

s(f) = st(t)e_fz”f‘ dt
(1)

111 METODE
A. Desain Sistem

Stimulasi alfa menggunakan audio relaksasi dan binaural
beats (8-13 Hz) untuk memengaruhi otak. Penelitian
dilakukan oleh Telkom University dan UNISBA untuk
mendukung aplikasi Neurobliss, yang membantu psikolog
menganalisis data EEG, menyimpan data pasien, dan
menampilkan berbagai stimulus.

/_\ Proses Pasca Pengolahan data ,/—\ \
| Mulai Pra perekaman o ¥ | Swp )
\_/ | perekaman . perekaman

[ sinyal EEG |
GAMBAR 1
(Alur Implementasi Sistem)

Implementasi tersebut merujuk kepada proyek capstone
design yang diawali dengan proses pemilihan reponden oleh
tim psikolog dari kemahasiswaan Universitas Telkom
Bandung. Responden terpilih akan dijadwalkan untuk
memasuki sesi eksperimen yang telah ditetapkan oleh tim
peneliti.

1. Pra Perekaman

Dalam persiapan pelaksanaan eksperimen, responden
yang telah terpilih akan memasuki ruang tunggu, alur tersebut
disebut tahap pra perekaman. Tahap ini bertujuan untuk
mengevaluasi awal kondisi psikologis responden oleh tim
psikolog dari UNISBA. Selanjutnya, tim peneliti akan
menjelaskan secara singkat mengenai pengujian stimulus
yang akan dilakukan.

2. Proses perekaman

Perekaman EEG dilakukan di ruangan khusus dengan
perangkat Muse S/2, gel EEG, tablet (Mind Monitor), laptop
(OBS), dan earphone. Stimulus audio BB 10 Hz dan musik
relaksasi digunakan untuk meredakan kecemasan. Proyek
capstone ini memanfaatkan Mind Monitor, Neurobliss, dan
OBS untuk merekam dan menganalisis data.

3. Pasca Perekaman
Setelah proses perekaman EEG selesai, responden
dipindahkan kembali ke ruangan awal untuk menjalani
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evaluasi psikologis oleh tim psikolog dari UNISBA. Evaluasi
dilakukan melalui pengisian form berisi pertanyaan
psikologis serta wawancara langsung guna menilai kondisi
responden setelah menerima stimulus alfa.

Sebagai bentuk apresiasi, responden diberikan reward
berupa makanan dan minuman atau saldo e-wallet. Seluruh
data hasil perekaman, baik dari alat EEG maupun video OBS,
disimpan dan diunggah ke link Google Drive yang telah
disediakan untuk keperluan dokumentasi dan analisis lebih
lanjut.

4. Pengolahan Data

Data dari aplikasi Mind Monitor disimpan dalam format
.csv, kemudian diproses melalui tahapan pre-processing
seperti ICA, pemfilteran sinyal, dan segmentasi
menggunakan FFT. Tujuan  utamanya adalah
mentransformasikan sinyal ke domain frekuensi agar daya
pada setiap frekuensi dapat dianalisis selama sesi stimulasi
EEG.

B.  Implementasi
1. Responden
Partisipan dengan kondisi mental normal dipilih oleh
psikolog Universitas Telkom berdasarkan kriteria tertentu
untuk menjaga validitas penelitian. Sebelum eksperimen,
partisipan diminta membaca dan menandatangani inform
consent yang disusun bersama psikolog UNISBA, berisi
kriteria serta prosedur pelaksanaan stimulasi.

"
|

GAMBAR 2
(Pengisian Inform Consent Oleh Responden)

2. Eskperimen

Penelitian ini bertujuan menguji efektivitas stimulasi
audio dalam meningkatkan gelombang otak alfa, yang
berkaitan dengan kondisi relaksasi. Stimulus bekerja dengan
cara mengosilasi frekuensi otak agar meningkatkan aktivitas
alfa, yang diamati melalui perubahan dari gelombang beta ke
alfa. Eksperimen ini membandingkan aktivitas otak sebelum
dan sesudah pemberian stimulus, serta menganalisis
perubahan daya frekuensi, terutama pada frekuensi alfa dan
high beta.
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GAMBAR 3
(Ilustrasi Pelaksanaan Perekaman Data Responden)

3. Perekaman Stimulasi

Partisipan awalnya diberi stimulus beta untuk
meningkatkan stres, lalu mendengarkan stimulus alfa guna
menginduksi relaksasi. Selama proses, EEG dan OBS
merekam respons otak dan ekspresi wajah, dibantu oleh
hardware, so tware, dan dua operator.

GAMBAR 4
(Pengambilan Data EEG dan Rekaman EEG)

C. Hardware

Untuk melakukan proses perekaman stimulus alfa
diperlukan alat atau device pendukung seperti Muse
(elektroda), laptop, tablet, webcam, earphone, dan gel eeg.
1. Wearable EEG Muse

Perangkat wearable Muse 2 dan Muse S Band seperti
pada Gambar 4.5 merupakan alat yang diproduksi oleh
Interaxon Inc., sebuah perusahaan neuroteknologi dari
Toronto, Kanada. Alat tersebut berfungsi untuk merekam
aktivitas sinyal listrik pada otak manusia. Muse EEG wireless
yang memiliki 4 channel yaitu TP9, AF7, AF8, dan TP10

GAMBAR 5
(Perangkat Muse S dan Muse 2)

2. Laptop
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Laptop merupakan perangkat yang digunakan untuk
menjalankan software Neurobliss yang berisi stimulus alfa
yang akan diputar oleh responden. Rekaman webcam
dilakukan melalui aplikasi OBS pada laptop.

GAMBAR 6
(Laptop)

3. Tablet atau HP Android

Tablet digunakan sebagai media perangkat untuk
menghubungkan perangkat elektroda Muse 2 dengan
software Mind Monitor berfungsi untuk merekam data sinyal
EEG. Tablet yang digunakan harus dengan system operasi
android.

GAMBAR 7
(Tablet)

4. Webcam

Webcam digunakan sebagai perangkat pendukung untuk
software OBS dalam merekam aktivitas responden. Webcam
yang digunakan saat stimulasi berjumlah 2 buah, yang
digunakan untuk merekam reaksi ekspresi dari depan dan
respon jawaban dari samping.

GAMBAR 8
(Webcam)

5. Earphone

Earphone sebagai perangkat untuk memaksimalkan
pengalaman responden pada sesi stimulus alfa dengan
mendengarkan suara/musik dari aplikasi Neurobliss caranya
dengan menyalurkan perbedaan bit di masing-masing telinga
dengan baik, dan meredam suara gangguan dari luar selain
stimulasi agar responden lebih fokus.
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GAMBAR 9
(Earphone)

6. Gel EEG

Gel EEG berfungsi sebagai konduktor antara kulit kepala
dengan perangkat Muse. Gel digunakan apabila elektroda
tidak dapat mendeteksi sinyal otak. Gel yang digunakan
merupakan gel konduktif.

%

. Cardio Gel -
-
-

/’ff o
\1t ‘Cardio Gel -

GAMBAR 10
(Gel EEG)

D. Software

Proses perekaman stimulus menggunakan software untuk
tujuan masing-masing. Untuk aplikasi Mind Monitor
digunakan sebagai platform media untuk merekam sinyal
EEG, kemudian aplikasi Neurobliss digunakan sebagai
platform media stimulus alfa. OBS digunakan untuk
merekam aktivitas yang dilakukan selama pengambilan data.
Aplikasi-aplikasi yang disebutkan ini digunakan selama
perekaman stimulus berlangsung.

1. Neurobliss
a) Aplikasi Neurobliss sebagai platform stimulasi

Neurobliss adalah aplikasi stimulus alfa yang
menyajikan dua audio dengan frekuensi alfa, berisi
kombinasi musik relaksasi dan binaural beats.
Dikembangkan dengan Flutter dan Dart untuk
desktop Windows, aplikasi ini ringan, offline, dan
menjaga privasi pengguna.

b) Fungsi dan desain aplikasi Neurobliss

e Halaman Depan: Dibuat dengan antarmuka
yang sederhana dan intuitif, menampilkan
kolom informasi pengguna yang dibutuhkan
untuk login, serta tombol navigasi ke menu
utama. Halaman ini juga memiliki fitur untuk
mengubah password jika user lupa password
sebelumnya. User akan diberikan beberapa
pernyataan sebelum dapat mengganti
password.
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InputField Username

InputField Password
Ubah Password

Tombol Login

GAMBAR 11
(Halaman Depan)

e Halaman Utama: Kodingan halaman ini
memiliki fungsi utama sebagai antarmuka awal
yang menampilkan 4 tombol navigasi utama.
Setiap tombol menggunakan desain visual yang
sederhana namun konsisten.

@ o e |

Tombol Daftar Responden

Tombol Registrasi Responden

Tombol Menu Sesi Audio

Tombol Menu Analisis

GAMBAR 12
(Halaman utama)

e  Halaman Registrasi: Pada halaman ini,
pengguna dapat mengisi data diri berupa nama
lengkap, umur, serta instansi

*

InputField untuk mengisi data
—— diri responden (nama lengkap,
umur, instansi)

Tombol untuk meng-submit
data diri responden

GAMBAR 13
(Halaman register)

e Halaman Daftar Responden: Halaman ini
berfungsi untuk menampilkan daftar responden
yang telah terdaftar. Pengguna juga dapat
mengedit dan menghapus data mereka yang
telah tersimpan menggunakan
SharedPreferences. Berikut adalah bagian
kodingan dari halaman daftar responden.

Tombol Hapus Data Responden
Tombol Edit Data Responden
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GAMBAR 14
(Halaman daftar responden)

e Halaman Sesi: Pengguna dapat memilih audio
berupa binaural beats maupun musik sebelum
memulai sesi di halaman ini. Hal ini bertujuan
untuk memberikan pengalaman personalisasi
audio kepada pengguna sebelum memulai sesi
enhanced alpha.

@ :

Daftar Audio Binaural Beats

“, — | Saja

Daftar Audio Musik + Binaural
Beats

GAMBAR 15
(Halaman Sesi)

e Halaman Pemutar Audio: Halaman ini
berfungsi untuk menampilkan sesi pemutaran
audio yang dipilih pengguna di halaman
sebelumnya, disertai dengan timer hitung
mundur.

Tampilan Ketika Audio
Dimainkan

' ‘PEIJGRE?SS.

GAMBAR 16
(Halaman pemutar audio)
e Halaman Analisis: Pengguna bisa mengelola
dan menganalisa hasil data dari sesi yang telah
dilakukan, secara online maupun offline.

-

Tombol untuk menganalisis
hasil rekaman EEG secara
online

Tombol untuk menganalisis
hasil rekaman EEG secara
offline

GAMBAR 17
(Halaman analisis)

Mindmonitor.com merupakan tampilan untuk
analisis menggunakan web yang disediakan
dari aplikasi mind monitor.
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Online Charts

GAMBAR 18
(mind-monitor.com/Chart.php)

e  Csvgraphs.exe merupakan tampilan untuk
analisis data mentah yang menampilkan
visualisasi magnitude sinyal delta, teta, alfa,
beta, dan gama.

A r =

arert | illands e Flc

LR hes o Ahe ol Games

aviect L large

STz 0
sAnmel

GAMBAR 19
(csvgraphs.exe)

2. OBS Studio

OBS Studio digunakan untuk merekam aktivitas
responden selama sesi, dengan dua webcam: satu merekam
wajah, satu lagi merekam tangan dan layar. Kedua video
digabung dalam satu layar dengan timestamp lewat OBS.

00:00:00,00

GAMBAR 20
(OBS Studio)

3. Mind Monitor
Mind Monitor merupakan aplikasi pihak ketiga yang
dibuat secara khusus untuk perangkat Muse. Aplikasi ini
berfungsi untuk membaca, menampilkan, dan merekam
data gelombang otak EEG dari Muse secara langsung.
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GAMBAR 21

E.  Tujuan Pengembangan Aplikasi Neurobliss

Tujuan utama dari aplikasi Neurobliss adalah menjadi
platform terapi audio bagi individu yang mengalami stres
atau tekanan psikologis. Dengan menyediakan stimulus alfa
dalam bentuk audio yang mudah diakses, aplikasi ini
diharapkan dapat membantu pengguna mencapai kondisi
relaksasi lebih cepat dan efektif.

F.  Stimulus Alfa Berbasis Audio

Stimulasi alfa dilakukan dengan kombinasi musik
relaksasi dan Binaural Beats (BB) yang menciptakan ilusi
frekuensi 10 Hz dalam rentang gelombang alfa. Musik
bertempo lambat dan suara alam ditambahkan untuk
meningkatkan kenyamanan. Audio dibuat dengan Audacity
3.6, menggunakan frekuensi 240 Hz dan 250 Hz pada telinga
kanan dan kiri. Kombinasi ini efektif meningkatkan aktivitas
gelombang alfa dan mencegah kebosanan, dengan durasi
sekitar 5 menit.

P C I T B R EERE
* =

&l -
N T R T P R Y

200 2 -

GAMBAR 22
(Kombinasi Audio di Aplikasi Audacity)

G. Kuesioner

Responden mengisi dua kuesioner sebelum dan sesudah
stimulasi untuk menilai kondisi psikologis dan efektivitas
stimulasi secara non teknis.

H. Pengolahan Data Sinyal EEG
Filtering BPF

L

Konversi file CSV
ke EDF

e

Dekomposisi ICA

==

GAMBAR 23
(Flowchart Pengolahan Data)

Konversi file EDF ke
CcsvV

Transformasi fourier
dengan FFT

Segmentasi sesual
durasi stimulasi

Output :
File csv

1. File CSV
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Dalam proyek capstone ini, data EEG mentah diperoleh
dari eksperimen stimulus menggunakan aplikasi Mind
Monitor pada tablet, lalu diekspor ke PC dalam format .csv.
Data tersebut belum melalui proses pre-processing seperti
filtering atau ICA. Penelitian difokuskan pada empat channel
EEG, yaitu TP9 dan TP10 (area Temporo-Parietal) serta AF7

dan AF8 (area Anterior Frontal).
TimeStamp ~ RAW_TPS RAW_AF7 RAW_AF8 RAW TP1(
03:30.3
03:30.3 819.1575
03:30.3 1650
03:30.3 1650

796.9963 808.2784 387.6191
839.707 823.5887 1526.3
822.381 824.7985 1650
03:30.3 807.8755 778.8644 805.4579 1009.341
03:30.3 0 751.0623 785.7143 0
03:30.3 692.2344 803.8461 804.652 240.5495
03:30.3 1643.956 854.2125 823.5897 1374.799
03:30.3 1650 846.5568 820.7692 1650
03:30.3 963.8095 790.5494 803.4432 1071.392
03:30.3 0 726.4835 780.4762 0
03:30.3 663.6264 766.7766 794.9817 47.14286
03:30.3 1648.791 823.5897 815.9341 1122.967
03:30.4 1650 826.8132 813.5165 1650
03:30.4 1010.549 799.011 796.1905 1201.136
03:30.4 0 759.5238 776.8498 77.76556
03:30.4 633.0037 792.1612 793.7729 0
03:30.4 1644.359 850.1832 817.9487 949.707
03:30.4 1650 853.8095 816.7399 1650
03:30.4 1015.788 820.3663 806.6667 1402.198
GAMBAR 24

(Data Mentah Rekaman EEG)

2. Flitering BPF (Band Pass Filter)

Setelah mendapatkan file csv dilakukan proses filter
BPF. BPF adalah jenis filter yang bertujuan untuk
memperoleh frekuensi di antara dua batas (lower cut-off
frequency dan upper-cut off frequency). Proses ini
merupakan proses awal yang penting karena gelombang otak
manusia memliki rentang frekuensi yang terbatas yaitu delta,
teta, alfa, beta, dan gama.

% Buat filter bandpass 0.5-¢0 Hz
[k, al] = butter(4, [0.5 €0]/(Fs/2), 'bandpass

% Terapkan filter
filtered wvalues = filtfiltik, a, raw values);

GAMBAR 25
(Skrip Pemrograman MATLAB Filter BPF)

Dalam pengolahan sinyal EEG, digunakan filter
Butterworth orde 4 dengan Band Pass Filter (BPF) pada
rentang 0,5-60 Hz. Filter ini dipilih karena memiliki respon
frekuensi yang halus tanpa riak di passband, dan orde 4
dianggap ideal agar tidak menimbulkan distorsi sinyal, yang
umum terjadi pada orde yang lebih tinggi.
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GAMBAR 26
(Perbandingan Sinyal Sebelum (atas) dan Sesudah di Filter
dengan BPF)

3. Konversi ke EDF

Sebelum melakukan dekomposisi ICA, data csv perlu
dikonversi ke format EDF, hal ini perlu dilakukan agar file
tersebut bisa melewati tahap proses dekomposisi ICA di
aplikasi MATLAB. Konversi ke EDF dilakukan di website
google colab menggunakan bahasa python.

# = Fungsi Fonwersi CSV ke EDF ==
def convert csv to edf{file name csv, sarple frequency=35€, selected colums=None
try:
df = pd.read csvifile name csv)
if selected columns is not Nome:
missing cols = [col for col in selected columns if col mot in df. colume
if missing cols:
raise ValusError(£"Kolom tidak ditemikan di CSV: {missing cols}")
df = df[selected colums]

df_rumeric = df.select_dtypes(include=[np.mmber])
if df numeric.empty:
raise ValueError ("Tidak ada kolom mumerik setelah filter.™)

signals = df rumeric.to numpy().T
signals = mp_nan to mumisignals)
n chamnels = signals.shape[0]

file name_edf = file name_csv.replace ("_csv”,
if os.path.exists (file_name_edsf) :
os_remove (file name edf)
channel_info = [1
for i in range(n chammels):
signal = signals[il
col name = df rumeric.colums[i]
channel info.appendi{
"label’: col_name,
'dimension': "WW',
"sample_frequency': sample_frequency,
‘physical min': float{np.mini{signall),
"physical max': float{np.max{signal)),
"digital min': —32763,
"digital mex': 32767,
'transducer': "'
"prefilter':
H

» edfn)

edf writer = pyedflib EdfWriter(file name edf, n chamnels=n channels)
edf writer setSignalHeaders (channel infc)

edf writer writeSamples(signals)

edf_writer.close()

print(£"[¥] File EDF berhasil dibuat: {file_name_edf}")
return file name edf

except Dxception as e:

print(£"X Erzor saat konversi CSV ke ZDF: {stz(e)}")
retuzn None

GAMBAR 27
(Kodingan Python EDF Converter)

4.  Dekomposisi ICA

Tahap dekomposisi ICA (Independent Component
Analysis) sangat penting dalam pengolahan data EEG karena
berfungsi untuk menghilangkan noise dan artefak dari
aktivitas non-otak, seperti gerakan otot atau kedipan mata,
yang hanya muncul pada kanal tertentu. ICA mampu
mengidentifikasi dan membersihkan kanal yang mengandung
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mayoritas gangguan. Proses ini dijalankan menggunakan
MATLAB dengan bantuan EEGLAB, sebuah toolbox khusus
untuk pemrosesan sinyal EEG.

v2025.0.
a4 EEGLAB v2025.0.0

File Edit Tools Plot Study Datasets Help o

——No current dataset

Suggested steps to get started

- Create a new or load an existing dataset:
Use "File > Import data" (new)
Oor "File > Load existing dataset" (load)
(find tutorial data in sample data folder)

— If newly imported raw dataset E

"Edit > Channel locations" (look up locations) |

"File > Import event info" (for continuous data)

5 — Filter data: "Tools > Filter data"

- Reject data: "Tools > Reject data by eye"

- Run ICA: "Tools > Run ICA" (can take time)

- Reject by ICA: "Tools > Reject data using ICA"™

— Epoch data: "Tools > Extract epochs"

— Plot ERP: "Plot > Channel ERP > In scalp array"

T TR

GAMBAR 28
(EEGLAB)

Proses analisis ICA bertujuan untuk menghilangkan
komponen noise tanpa merusak keseluruhan sinyal otak pada
kanal EEG. Meskipun komponen artefak dihapus, sinyal
tetap terdistribusi dengan baik. Contohnya, pada Gambar
4.37 ditunjukkan penghapusan komponen ke-4 yang
didominasi oleh line noise.

Brain : 88.2% Brain : 77.0%

Line Noise : 64.0%

_r

1w

Brain : 97.5%

Brain : 88.6% Brain : 71.4%

GAMBAR 29
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(ICA Analisis Menghapus Komponen Line Noise)

5. Konversi ke CSV

Data hasil analisis ICA disimpan dalam format EDF dan
perlu dikonversi kembali ke .CSV untuk lanjut proses
transformasi fourier. Konversi data dilakukan melalui
kodingan python. Data hasil analisis ICA disimpan dengan
format waktu ms, dan elektroda TP9, AF7, AF8, TP10

edf_reader = pyedflib Edfleader(edf_file)
n_channels = edf reader.signals in File
signal_labels = edf reader.getSignallabels()
sample_rate = edf_reader.getSampleFrequencyid)
n_samples = edf_reader.getNSamples () [0]

£ Arbil data dari semua channel
data = np_zeros((n_sarples, n_chammels))
for i in range(n_channels):

datal:, i] = edf reader.readSignal{i)
edf_reader.close()

¢ Buat timestamp

timestamps = np.arange(n samples) / sample rate
¢ Simpan ke DataFrame dan CSV

df = pd.DataFrame|data, columns=signal labels)
df.insert(0, 'TimeStarp', timestamps)
df.to_csviesv_output, index=False)

GAMBAR 30
(Konversi EDF ke CSV)

6. Fast Fourier Transform

Dalam analisis EEG, sinyal dikategorikan menurut
rentang frekuensi gelombang otak seperti delta, theta, alpha,
beta, dan gamma. Karena sinyal awal berada di domain
waktu, diperlukan konversi ke domain frekuensi
menggunakan metode Fast Fourier Transform (FFT), yaitu
algoritma yang secara efisien mengubah sinyal agar
komponen frekuensinya dapat dianalisis.

% —— Plot :

EFT dari Segmen ——

subploti€,1,1);

)i
cfloorin/2i+l) ;

-1} = 2*Pl{2:end-1);
n/2) /n;

k')

title({sprintf ('FFT dari Segmen (%.2f - %.2f detik)',t _segment sbs(l),
t_segment_abs (end) )17
xlabel ["Freluensi (Hz)'); ylabel('Magnitudo');

x1im([0 €01)5

GAMBAR 31
(Skrip FFT pada Pemrograman MATLAB)

7. Segmentasi Awal dan Akhir

Setelah klasifikasi frekuensi dilakukan, sinyal EEG
disegmentasi berdasarkan waktu saat responden menerima
stimulus. Segmentasi ini membandingkan aktivitas otak saat
stimulus video/game dengan stimulus binaural beats (BB).
Sinyal kemudian divisualisasikan dalam rentang 0,5-60 Hz
dan dipisahkan sesuai dengan osilasi gelombang otak.

e e 12 20 7509

Ot 3 St

Thuea 4 4

GAMBAR 32

(Klasifikasi Frekuensi Sinyal ke Pita Frekuensi Delta, Teta,
Alfa, Beta, dan Gama)

V. HASIL DAN PEMBAHASAN
A. Pengujian Aplikasi
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Pengujian awal aplikasi dilakukan dalam sesi trial untuk
menilai kinerja sebelum digunakan lebih lanjut. Evaluasi
dilakukan oleh tim peneliti EEG dan UNISBA, dengan
penilaian meliputi kemudahan akses, performa, tampilan, dan
keamanan, menggunakan skala 1-5. Nilai rata-rata dihitung
dari seluruh skor responden, kemudian diklasifikasikan ke
dalam kategori penilaian berdasarkan rentang nilai yang telah
ditentukan. Berikut kategori skor 1-5 untuk penilaian aplikasi
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10 Layout halaman dirancang | 4,31
agar nyaman digunakan
dalam jangka panjang
11 Aplikasi tetap stabil tanpa 4,50
error atau crash selama
pemberian stimulus

12 Evaluasi secara menyeluruh | 4,62
menunjukkan bahwa baik
dari sisi desain maupun

Setuju

Setuju

Setuju

a. Nilai 1 = Sangat Tidak Setuju operasional, aplikasi ini

b.  Nilai 2 = Tidak Setuju telah dirancang dengan

c.  Nilai 3 = Netral baik untuk memenuhi

d. N¥1a¥ 4 = Setuju ' kebutuhan pengguna

e. Nilai 5 = Sangat Setuju B.  Pengujian Data EEG

Bandpass Filter Konversi CSV
TABEL 1 Dataset awal = (]1)31:1:) R ke EDF
(Evaluasi Aplikasi Trial) Artifact

Paramater Nilai removal ICA
Kemudahan Akses 4,58 Segmentasi [— Koi;e(lzs; \]:EDF | Koi\eeés; \]:EDF ‘—]
Performa Aplikasi 4,50 GAMBAR 33
Tampilan Aplikasi 5,00 (Diagram Proses Tahapan Pengujian)
Keamanan Aplikasi 4,83

Evaluasi awal dari tim EEG sangat positif, dengan skor
tertinggi 5.00 untuk tampilan. Keamanan, akses, dan
performa juga dinilai baik. Pengujian lanjutan oleh 32
responden lewat Google Form menguatkan kualitas aplikasi
secara keseluruhan.

Dataset yang kami peroleh dari hasil perekaman EEG
akan diimpor ke perangkat desktop untuk proses pengolahan
lebih lanjut. Tahap pertama yang harus dilakukan ada proses
penyaringan menggunakan Band-pass Filter (BPF) melalui
MATLAB karena hanya 4 channel yang akan kami olah yaitu
TP9, AF7, AF8, TP10.

TABEER TABEL 3
(Penilian Aplikasi Hasil Kuesioner) ‘ (Dataset Hasil Perekaman EEG)
No | Pertanyaan Rata- Kategori TimeSamp | RAW TPO | RAW AF7 | RAW AF8 | RAW TPI10
;?(Isr 00:01:24.9 23.4311 -5.89678 7.21773 9.297698
1 Seberapa mudah pengguna 4,56 Setuju 00:01:24.9 | 636.5617 649.1396 663.4152 620.1349
glljirll(lggf‘)ml antarmuka 00:01:250 | 9344297 | 9205048 | 9429647 | 8803667
2 Penggunaan font 4,50 Setuju 00:01:25.0 | 936.1657 377.8042 888304 3604584
gﬁ;ﬁﬁ?ﬁ;ﬁfiﬁgﬁghsan Tabel diatas menampilkan contoh dataset responden yang
3 Seberapa mudah pengguna 143 Setuju telah Ir'lelalu@ proses ﬁl.te?ring dan konversi da'ri CSV ke EDF
menemukan fitur yang ’ sebagai persiapan analisis ICA. Proses ICA digunakan untuk
dibutuhkan? mendekomposisi sinygl .EEG_ menjadi kpmponen
4 Bagaimana tingkat respons | 4,50 Setuju mdependep,_ serta mengidentifikasi a}rtefak seperti gerakan
aplikasi saat pengguna mata, aktivitas otot ra.hang,. dgn line noise yang dapat
menggunakannya? mengganggu proses klasifikasi sinyal.
5 Apakah aplikasi terasa aman | 4,40 Setuju
dalam hal perlindungan data
pribadi?
6 Seberapa puas anda dalam 4,46 Setuju
hal mengenai desain visual
aplikasi?
7 Seberapa nyaman tata letak 4,46 Setuju
dan desain aplikasi bagi
pengguna?
8 Seberapa cepat aplikasi 4,53 Setuju
memuat halaman atau fitur
yang akan digunakan?
9 Aplikasi mudah digunakan 4,37 Setuju
tanpa perlu penjelasan
tambahan
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-

Brain : 92.7% Brain : B5.2% Brain : 77.0%
S =
Line Noise ' 64.0%
A
GAMBAR 34
(Hasil Proses ICA)

ﬂ View components properties -...

l Brain : 88.6% Brain : 97.5% Brain : 71.4%
GAMBAR 35

(Output ICA Setelah Remove Components from Data)

Setelah proses dekomposisi selesai, data bersih
(processed data) kemudian diubah kembali formatnya dari
EDF ke CSV untuk proses analisis selanjutnya. Data
kemudian akan diplot dan dianalisis menggunakan Fast
Fourier  Transform  (FFT) yang bertujuan untuk
mengklasifikasikan spektrum sinyal otak berdasarkan
karakteristik frekuensinya.

GAMBAR 36
(Magnitude Stimulus Audio)
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GAMBAR 37
(Daya Stimulus Audio)

C. Hasil Pengujian

Eksperimen stimulus enhanced alfa menggunakan audio
Binaural Beats (BB) bertujuan meningkatkan osilasi sinyal
alfa (10 Hz) untuk menciptakan relaksasi. Efektivitas BB
dinilai dari penurunan stres, yang dilihat melalui perubahan
frekuensi dan daya sinyal beta (terutama beta tinggi 22—30
Hz yang berkaitan dengan kecemasan). Analisis
membandingkan osilasi sinyal alfa dan beta selama stimulus
video dan dua sesi audio, dari 5 responden namun hanya 3
data yang dapat digunakan. Hasil perbandingan ditampilkan
pada Tabel 4 (alfa) dan Tabel 5 (beta).

TABEL 4
(Analisis Frekuensi Alfa)

Respo | Video Audio SI Audio SII
nden

Frek. Daya Frek. Daya Frek. Daya
RV1 9,75 13,04 19,5 15,49 29,5 12,69
RV4 9,75 12,12 19,5 12,82 29,5 12,49
RVS 8,00 11,96 19,5 3,16 19,5 0,38

Tabel menunjukkan frekuensi alfa stabil di tiap
responden, namun dayanya bervariasii RV1 mengalami
lonjakan daya tertinggi saat Audio SI, sedangkan RVS justru
menurun drastis. Ini menunjukkan respons individu berbeda-
beda terhadap stimulus; RV1 paling sensitif, RV4 moderat,
dan RVS5 paling rendah. Temuan ini menegaskan bahwa
modulasi otak harus disesuaikan secara personal.

TABEL 5
(Analisis Frekuensi Beta)

Respo | Video Audio SI Audio SII
nden

Frek. Daya Frek. Daya Frek. Daya
RV1 21,25 12,58 19,5 15,49 29,5 12,69
RV4 19,5 12,04 | 195 12,82 | 295 12,49
RV35 13,5 731 19,5 3,16 19,5 0,38

Tabel 5 menunjukkan frekuensi beta cenderung stabil
pada RV1 dan RV4, namun melonjak ke 29,5 Hz pada Audio
SII, mencerminkan respons kognitif tinggi. RVS
menunjukkan frekuensi rendah dan daya menurun drastis,
terutama pada Audio SII. Daya beta tertinggi tercatat pada
RV1 saat Audio SI (15,49 uV*Hz), sedangkan RVS
mengalami penurunan ekstrem, kemungkinan karena
kelelahan atau gangguan fokus. Perbedaan ini menekankan
pentingnya pendekatan individual dalam pengaturan stimulus
kognitif.
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GAMBAR 38
(Visualisasi Perbandingan Frekuensi dan Daya)

Analisis kedua dilakukan wuntuk data rekaman
menggunakan stimulus game-audio. Data yang dapat
digunakan hanya dari 3 dari 5 responden. Responden diminta
memainkan stimulus game, kemudian dilanjutkan dengan
stimulus audio sebanyak dua sesi.

TABEL 6
(Analisis Frekuensi Alfa)
Respo Video Audio SI Audio SII
nden

Frek. Daya Frek. Daya Frek. Daya

RGl1 10,50 22,40 10,5 30,60 10,75 22,97

RG4 9,75 16,26 8,00 17,72 10,75 23,68

RG5 8 2,52 8,00 18,14 9 24,53

Tabel 6 menunjukkan bahwa RG2 konsisten memiliki
daya alfa tertinggi di semua stimulus dengan frekuensi stabil.
RG3 mengalami peningkatan daya meski frekuensinya
berfluktuasi, sementara RG4 menunjukkan lonjakan
signifikan dari daya rendah saat Game ke tinggi pada Audio
SII. Perbedaan ini mencerminkan sensitivitas individu
terhadap jenis stimulus, menekankan pentingnya intervensi
neuromodulasi yang dipersonalisasi.

TABEL 7
(Analsis Frekuensi Beta)

Respo Video Audio SI Audio SII
nden

Frek. Daya Frek. Daya Frek. Daya
RV1 21,25 12,58 19,5 15,49 29,5 12,69
RV4 19,5 12,04 19,5 12,82 29,5 12,49
RV5 13,5 7,31 19,5 3,16 19,5 0,38

Tabel 7 menunjukkan bahwa stimulus audio, khususnya
Audio SII, secara umum memicu peningkatan frekuensi dan
daya gelombang beta dibandingkan game. RG2
mempertahankan frekuensi stabil, namun daya tertinggi
muncul saat Audio SI. RG3 dan RG4 menunjukkan
peningkatan frekuensi dan daya signifikan, menandakan
respons kognitif kuat terhadap audio. Hasil ini menegaskan
bahwa efektivitas stimulus audio bersifat individual.
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Frevaens iz

GAMBAR 39
(Visualisasi Perbandingan Frekuensi dan Daya)

V. KESIMPULAN

Aplikasi Neurobliss terbukti stabil dan mudah digunakan
sebagai platform stimulasi sinyal alfa. Pengujian oleh 32
responden menghasilkan skor kepuasan rata-rata 4,47/5
untuk antarmuka, performa, dan keamanan data. Fitur
pemutaran audio binaural beats dan musik relaksasi berjalan
lancar tanpa error, sehingga aplikasi siap dipakai sebagai alat
bantu non-medis dalam pengelolaan kecemasan.

Analisis sinyal EEG mengonfirmasi bahwa Audio SI
menimbulkan lonjakan daya gelombang alfa hingga 1540 %
pada sebagian besar peserta, meskipun frekuensi dominan
tetap stabil di 8-10 Hz. Audio SII dan stimulus game—audio
secara konsisten meningkatkan frekuensi dan daya
gelombang beta—tanda peningkatan kewaspadaan kognitif
atau potensi stres. Variasi respons individu, termasuk
beberapa penurunan daya alfa, menegaskan pentingnya
personalisasi protokol stimulasi.

Secara keseluruhan, Neurobliss berhasil memenuhi tujuan
penelitian dengan memfasilitasi observasi perubahan alfa dan
beta melalui antarmuka praktis. Aplikasi ini tidak hanya
mendemonstrasikan efektivitas stimulasi enhanced alpha
dalam mereduksi kecemasan, tetapi juga menyediakan
mekanisme monitoring beban mental berbasis EEG. Temuan
ini mendukung implementasi teknologi neuromodulasi yang
dapat disesuaikan untuk intervensi kesehatan mental di
kalangan mahasiswa.
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